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PREFACE 

This guide describes how to use the STEP File Analyzer and Viewer, a software tool that analyzes and 
generates a spreadsheet or a set of CSV (comma-separated value) files from an ISO 10303 STEP 
(STandard for the Exchange of Product model data) file.  The spreadsheets simplify inspecting 
information in the STEP file at an entity and attribute level.  STEP files can also be checked for 
conformance to recommended practices for Product and Manufacturing Information (PMI) representation, 
PMI presentation, and validation properties. 

The STEP File Analyzer and Viewer also generates views of part geometry, graphical PMI annotations, 
tessellated part geometry, sketch geometry, supplemental geometry, and finite element models.   

More information about the software and sample spreadsheets and views can be found at 
https://www.nist.gov/services-resources/software/step-file-analyzer-and-viewer.  The source code for the 
software is available at https://github.com/usnistgov/SFA. 

In this report the acronym SFA will be used for the STEP File Analyzer and Viewer. 

UPDATES 

The first version of this User Guide was published in 2012.  For Update 6 of this guide, in addition to 
updated figures, new content is found on this page and in sections: (1) Introduction, (3.4) Options tab, 
(4) Viewer, (5) Spreadsheets, (6.1.7, 6.5.2, 8.2.1) PMI Representation Coverage Analysis, and (7) Syntax
Checker.  Many sections have been reordered from the previous version.

DISCLAIMERS 

Any mention of commercial products in SFA and this User Guide is for information purposes only; it 
does not imply recommendation or endorsement by the National Institute of Standards and Technology 
(NIST).  For any of the web links in the software and this User Guide, NIST does not necessarily endorse 
the views expressed, or concur with the facts presented on those web sites. 

NIST-developed software is provided by NIST as a public service.  You may use, copy and distribute 
copies of the software in any medium, provided that you keep intact this entire notice.  You may improve, 
modify and create derivative works of the software or any portion of the software, and you may copy and 
distribute such modifications or works.  Modified works should carry a notice stating that you changed 
the software and should note the date and nature of any such change. Please explicitly acknowledge the 
National Institute of Standards and Technology as the source of the software. 

Please also refer to the NIST Disclaimer and the NIST Software Disclaimer. 
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1 Introduction 
 
The STEP File Analyzer and Viewer [2] processes STEP (ISO 10303 – informally known as the 
STandard for Exchange of Product model data) [3, 4] files.  A STEP file refers to a file that is typically 
exported by CAD (Computer-Aided Design) software in a format described by ISO 10303-21 and known 
as a Part 21 file [5]. 
 
In this report the acronym SFA will be used for the STEP File Analyzer and Viewer. 
 
SFA supports current and some older editions of the following STEP Application Protocols (AP), also 
known as STEP schemas.  An AP is the implementable part of ISO 10303 upon which STEP import and 
export translators are based on for a particular engineering domain. 
 

• AP203 – Configuration Controlled 3D Design of Mechanical Parts and Assemblies [6] 
o The older version of AP203 is known as Config Control Design 

• AP209 – Multidisciplinary Analysis and Design [7, 8] 
o The older version of AP209 is known as Structural Analysis Design 

• AP210 – Electronic Assembly Interconnect and Packaging Design [9] 
• AP214 – Automotive Design [10] 
• AP238 – Integrated CNC Schema [11, 12] 

o The newer version of AP238 is known as Model Based Integrated Manufacturing Schema 
• AP239 – Product Life Cycle Support (PLCS) [13, 14] 
• AP242 – Managed Model Based 3D Engineering [15-17] 

 
IFC (Industry Foundation Classes) [18-20] and CIS/2 (CIMsteel Integration Standards) [21, 22], used in 
the building and structural steel industries, respectively, are also supported.  Parts 25 and 42 from the ISO 
13584 Parts Library (PLIB) schema are also supported.  A complete list of supported APs can be found in 
the SFA Help menu under Supported STEP APs. 
 
There are four main features of SFA. 
 
1. SFA is a viewer for part geometry, sketch geometry, graphical PMI annotations, tessellated part 

geometry, supplemental geometry, and finite element models.  The viewer is described in section 4. 
 
2. SFA generates a spreadsheet or a set of CSV (comma-separated value) files from a STEP file. The 

spreadsheets or CSV files simplify inspecting information from the STEP file at an entity and 
attribute level.  Spreadsheets are described in section 5. 

 
3. SFA can also analyze a STEP file for conformance to recommended practices for Product and 

Manufacturing Information representation (semantic PMI), PMI presentation (graphical PMI), and 
validation properties.  Recommended practices are defined by the CAx Interoperability Forum  
(CAx-IF)  [23].  Checking recommended practices is described in section 6. 

 
4. SFA can check for basic syntax errors and warnings in STEP files related to missing or extra 

attributes, incompatible and unresolved entity references, select value types, illegal and unexpected 
characters, and other problems with entity attributes.  Some errors might prevent SFA and other 
software from processing a STEP file.  The syntax checker is described in section 7. 
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2 Getting Started 

2.1 Install SFA 
SFA was developed for Windows computers and is a 32-bit application.  Microsoft Excel is required to 
generate a spreadsheet.  If Excel is not installed, then CSV files will be generated instead of a 
spreadsheet. 
 
The link to the download request form for SFA can be found on  
https://www.nist.gov/services-resources/software/step-file-analyzer-and-viewer.   You will receive 
instructions about where to download SFA after submitting the download request.  SFA is downloaded as 
a zip file named sfa-n.nn.zip where n.nn is the version number. 
 
The installation process does not require anything more than unzipping sfa-n.nn.zip.  The zip file contains 
five files: 
 

1. STEP-File-Analyzer.exe – Graphical user interface (GUI) version of SFA 
2. STEP-File-Analyzer-CL.exe – Command-line version (section 9) 
3. SFA-User-Guide-v6.pdf – This User Guide 
4. SFA-README-FIRST.pdf – A readme file 
5. STEP-File-Analyzer-changelog.xlsx – Summary of new and updated features 

 
There are no restrictions as to where the files are located on your computer’s file system. 

2.2 Run SFA 
To run SFA, simply double click on the icon for STEP-File-Analyzer.exe.  Several setup functions are 
performed the first time you run SFA: 
 

1. The What’s New information is shown in the Status tab. 
2. The Disclaimers dialog is opened. 
3. This User Guide is opened. 
4. You are asked if a shortcut to SFA can be created in the Start Menu and if an icon for SFA can be 

placed on the Desktop. 
5. The Crash Recovery dialog is opened (section 2.4). 
6. A file STEP-File-Analyzer-options.dat is created in your home directory that stores the current 

state of SFA options.  Do not edit this file. 
7. The installation for the IFCsvr toolkit is automatically started. 

 
2.2.1 Install IFCsvr 
The IFCsvr toolkit1 is used to read and process STEP files. The IFCsvr installation program is 
automatically started.  You might need administrator privileges to install the toolkit.  The installation 
program might cause antivirus software to respond that there is an issue with the toolkit.  The toolkit is 
safe to install.  For example, if the Windows Defender antivirus software responds that there is an issue 
with the toolkit, select More Info and Run Anyway.   
 
Two of several installation dialogs are shown in Figure 1.  Use the default installation folder as shown in 
the right dialog.  You must let the installation process complete before processing any STEP files with 
SFA.   

 
1 The IFCsvr toolkit used to be available in a Yahoo Group. 

https://www.nist.gov/services-resources/software/step-file-analyzer-and-viewer
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Although the IFCsvr toolkit was originally written to process IFC files [18] used in the building and 
construction industry, it has been adapted to work with STEP files. 
 

  
 

Figure 1: IFCsvr installation dialogs 
 
Sometimes with a new version of SFA, you will be prompted to reinstall IFCsvr to update the STEP 
schemas.  This requires removing the existing version of IFCsvr and installing the new version. 
 
If you Cancel the IFCsvr toolkit installation, you will still be able to user the Viewer for Part Geometry 
(section 4.1).  Select View Only and Part Only in the Output Format section of the Options tab (section 
3.4.1). 

2.3 Generate Output 
After the IFCsvr toolkit is installed, you can generate a spreadsheet and view from a STEP file.  Go to the 
File menu, select Open STEP File(s), select a STEP file on your computer, click Open in the dialog, and 
then click on the Generate Spreadsheet and View button. 
 
Feedback will appear in the Status tab indicating the progress of processing the STEP file.  The 
spreadsheet will be opened after it has been generated and the view will open in the default web browser.  
If CSV files are generated, the directory where the CSV files were generated will be opened.  One CSV 
file is generated for each entity type. 

2.4 Recover from a Crash 
Sometimes SFA will unexpectedly stop (crash) when processing a STEP file.  This is usually due to either 
bugs in the STEP file or limitations of the IFCsvr toolkit.  If this happens, simply restart SFA and process 
the same STEP file again by using function key F1 or F6 if processing multiple STEP files.  SFA might 
also crash when processing very large STEP files.  Figure 2 shows a dialog that is opened the first few 
times SFA is run.  SFA keeps track of which entity type caused the crash for a particular STEP file and 
will not process that type again.  More details about recovering from a crash are explained in section 10.  
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Figure 2: What to do if the STEP File Analyzer and Viewer crashes 
 

2.5 Uninstall SFA 
SFA can be uninstalled by manually deleting the two executable files and PDF files, the STEP-File-
Analyzer-options.dat file in your home directory, and the desktop icon for SFA.  The IFCsvr toolkit can 
also be deleted from Apps in Windows Settings.  Temporary files can also be deleted from 
C:/Users/username/AppData/Local/Temp/SFA. 
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3 User Interface 
 
Figure 3 shows the SFA user interface running on a Windows 10 computer.  At the top of the user 
interface is the Menu bar with the File, Websites, Examples, and Help menus.  Below that is the Tabs bar 
with tabs for Status, Options, and Spreadsheet.  Below that is the Status window that shows text feedback 
when SFA is running.  Clicking on the Options and Spreadsheet tabs will switch to the user interface for 
those tabs.  At the bottom of the user interface is the Generate Spreadsheet and View button, NIST logo, 
and progress bar. 
 

 
 

Figure 3: User interface  

< Menu bar 
< Tabs bar 
 
 
 
 
 
 
 
 
 
 
< Status tab with 
text feedback 
 
 
 
 
 
 
 
 
 
 
 
 
< Generate 
button 
 
< Progress bar 
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3.1 Menu Bar 
The menu bar contains four items: File, Websites, Examples, and Help menus. 
 
3.1.1 File Menu 
From the File menu, shown in Figure 4, you can select a single STEP file to process with  
Open STEP File(s).   STEP files with extensions of .stp, .step, and .p21 are recognized.  Compressed STEP 
files with an extension of .stpZ are also recognized.  ISO 10303 Part 21 Edition 3 STEP files are also 
supported [5, 24] (section 5.7).  AP238 files with a .stpnc file extension are supported if the file extension 
is changed to .stp. 
 
Multiple STEP files can be processed at one time by selecting the Open Multiple STEP Files in a Directory 
option where you will be asked to select a directory to search for STEP files.  The search for multiple files 
can be restricted to only the selected directory or to include all subdirectories.   
 
Multiple STEP files can also be selected in the Open STEP File(s) dialog by holding down the control or 
shift key when selecting files.  When spreadsheets from multiple STEP files are generated, a File 
Summary spreadsheet is also generated as described in section 8.1. 
 
Below the first solid line in the File menu is a list of up to 20 of the most recently translated STEP files 
that can be opened directly.  Function keys, defined in the Help menu, can be used to access features of 
the File menu and other functions. 
 

 
 

Figure 4: File menu 
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3.1.2 Websites Menu 
The Websites menu, shown in Figure 5, provides links to useful resources related to SFA, NIST research, 
CAx-IF resources, Interoperability Forums (IF), AP242, and the STEP format, schemas, software, and 
related organizations. 
 
3.1.3 Examples Menu 
The Examples menu, shown in Figure 6, has links to several sources of sample STEP files and sample 
views and spreadsheets generated by SFA. 
 

 
 
Figure 5: Websites menu 
 

 
 
Figure 6: Examples menu 
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3.1.4  Help Menu 
The Help Menu, shown in Figure 7, has six sections.  In the first section, User Guide a link to this 
document.  What’s New shows information in the Status tab about important new features in SFA.  
Changelog opens the spreadsheet of changes for each version of SFA.  Check for Update opens up a web 
page that checks for the latest version of SFA.   Follow the instructions on that web page to download a 
new version of SFA if one is available.  This feature runs automatically if an update hasn’t been checked 
for in the last 30 days.  The other topics in the Help menu show information in the Status tab and are 
similar to most information in this User Guide.   
 

 
 

Figure 7: Help menu 
 
Help is also available in the form of tooltips related to some of options in the tabs.  Holding the mouse 
over any text in a tab for a second or two will show a tooltip.  The AP242 tooltip help in the Options tab 
is shown in Figure 8. 
 

 
 

Figure 8: Tooltip help 
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3.2 Tabs Bar 
The Tabs bar is located directly below the menu bar in Figure 3.  Clicking on a tab will switch from the 
current tab to the selected tab.  Except for the Status tab, the tabs contain the options that affect how a 
spreadsheet is generated from a STEP file.  The options in the Options and Spreadsheet tabs are described 
in sections 3.4 and 3.5. 

3.3 Status Tab 
The Status tab shows important feedback during the generation of a spreadsheet from a STEP file.  You 
should not ignore the feedback as it provides useful information related to the success in processing the 
STEP file.  Some of the error, warning, or informational messages in the Status tab have a yellow 
background, red background, red, blue, or green text.  Syntax error messages (section 6.4) highlighted 
with a red background are for nonconformance of some aspect of the STEP file to a CAx-IF 
recommended practice [25].  Information in the Status tab is shown in Figure 3 and section 6.4.   
 
Text in the Status tab can be saved in a log file named myfile-sfa.log.  In the log file, color-coded 
messages are preceded by three asterisks (***). 
 
The following general sequence of status messages appears in the Status tab when a STEP file is 
processed: 
 

• Messages about Opening STEP file and Number of entities 
• Message about Generating Header worksheet and information from the STEP file header section 
• STEP entities listed in the order they are processed 

o The number in parentheses is the number of entities of that type in the STEP file 
o The types of entities processed depends on the entities selected in the Process section of 

the Options tab (section 3.4.2) 
• Possible messages about inverse relationships (section 5.6.1), checking recommended practices 

(section 6), and syntax errors (section 6.4) 
• Messages about Generating Summary worksheet, Formatting Worksheets, and Processing time 
• Messages about Saving and Opening the spreadsheet and view 
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3.4 Options Tab 
Figure 9 shows the Options tab that enables you to control which entities from the STEP file are written 
to the spreadsheet, to add supplemental analysis reports to some worksheets, and to generate views.  
Inverse Relationships are described in section 5.6.1. 
 

 
 

Figure 9: Options tab 
 
3.4.1 Output Format 
Information in a STEP file can be output to a spreadsheet or set of CSV files.  If Excel is installed, then a 
spreadsheet and CSV files can be generated.  If Excel is not installed, only CSV files can be generated.  If 
Excel is not installed, some features are not available with CSV files such as Reports (section 6) and 
Inverse Relationship (section 5.6.1).  CSV files do not contain any cell colors, comments, or links.  For 
CSV files, PMI annotations will look correct only with Excel 2016 or newer.   
 
Use the View Only option to only generate views without generating a spreadsheet or CSV files.  Use the 
Part Only option to view only part geometry. 
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3.4.2 Selectively Process Entity Types 
SFA can process any entity type for any schema listed by Supported STEP APs in the Help menu.  The 
checkboxes in the Process section of the Options tab allow you to selectively process different types of 
entities.  Each checkbox corresponds to a category of entities that is also used to group entities on the File 
Summary worksheet.  All entities unique to APs and schemas other than AP203, AP214, and AP242 are 
always processed, including AP209, AP210, AP238, AP239, IFC, and CIS/2. 
 
As a convenience, several buttons are available to quickly select multiple options. 
 

• All selects all categories except Geometry and Coordinates.   
• For Reports selects all Analyze options and associated entity categories.   
• For Views selects all View options and associated entity categories. 
• Reset deselects all categories, except for Common, and all reports and views.  

 
Selecting any Analyze option automatically includes the necessary entity categories related to that 
analysis.  For example, selecting the analysis for PMI Representation automatically selects the entity 
categories for Representation, Tolerance, Measure, Shape Aspect, and AP242, and disables deselecting 
them. 
 
By processing only certain types of entities, the size of and time to generate a spreadsheet can be reduced.  
The categories of entities are also used to order and color the entity names on the Summary worksheet 
and tabs for the entity worksheets as shown in Figure 34.  Each category of entities is assigned a different 
color and within each category the entities are listed in alphabetic order. 
 
Holding your mouse over some of the checkboxes for a second or two will show a tooltip that lists all of 
the entities in that category.  The tooltip for the Shape Aspect entities is shown in Figure 10 and specifies 
that there are 32 entities in the Shape Aspect category.  Some of the categories contain hundreds of 
entities where the associated tooltip might not fit on the screen or be displayed. 
 
A User-Defined List can also be used to set which entities will be processed.  The list is defined in a plain 
text file with the name of one entity type per line in lower case.  When the User-Defined List option is 
selected, the Browse button will be activated to select the file that contains the list of entities.  This option 
allows you more control to process only the required entity types.  It is also useful when processing large 
STEP files that might crash SFA. 
 

 
 

Figure 10: Tooltip help for Shape Aspect entities 
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3.4.3 Analysis Reports 
Recommended practices are specifications that provide common implementation guidance associated 
with specific functionalities for data exchange.  The CAx-IF has published recommended practices for 
communicating PMI representation, PMI presentation, and validation properties in STEP files [25].  
Recommended practices are not part of ISO 10303 EXPRESS schema.   
 
SFA checks the STEP file for conformance to those recommended practices.  Details about entity 
attribute values that specify conformance are reported on various worksheets.  Non-conformance is shown 
with messages in the Status tab and spreadsheet cells that are highlighted in red. 
 
Section 6.1 discusses the report for PMI representation.  Section 6.2 discusses the report for PMI 
presentation.  Section 6.3 discusses the report for validation properties. 
 
3.4.4 View Options 
Views for part geometry, graphical PMI annotations, AP242 tessellated part geometry, and AP209 finite 
element models can be generated.  Section 4 describes the view options. 
 
3.4.5 Open STEP File in Apps 
The Open STEP File in Apps option is a convenient way to open a STEP file in other applications.  Figure 
11 shows the pull-down menu listing some of the applications that can open a STEP file on the author’s 
computer.  The pull-down menu will always contain a text editor, Default STEP Viewer, and  
Tree View (for debugging) which is described below.  The Default STEP Viewer is whichever application 
is associated with STEP files (.stp file extension).  Several STEP file viewers and conformance checkers 
also appear in the pull-down menu.  Applications will appear in the pull-down menu if they are installed 
in their default location.  To open a STEP file in one of the applications, select the application from the 
pull-down menu and click the Open button.   
 

 
 

Figure 11: Open STEP File in other applications 
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3.4.5.1 Tree View for Debugging 
The option for the Tree View (for debugging) will show the STEP file in a text editor; however, the STEP 
entities will be rearranged and indented to show the hierarchy of information in the STEP file.  This is a 
useful feature to help debug a STEP file, however it is not recommended for large STEP files.  Figure 12 
shows a sample of the tree view output.  In this sample, it is easy to see how flatness_tolerance (#5584) 
refers to length_measure_with_unit (#5585) and datum_feature (#5583).  The tree view output of the 
STEP file starts with entities that will generate useful output and stops with other entities to prevent the 
tree view file from getting too large.  Basic geometric and styled item entities can optionally be included 
in the tree view file, which will increase the size of the file.  The resulting tree view file is named 
myfile-sfa.txt 
 

 
 

Figure 12: Tree View output 
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3.5 Spreadsheet Tab 
The Spreadsheet tab, shown in Figure 13, contains several more options that affect how information is 
written to the spreadsheet. 
 

 
 

Figure 13: Spreadsheet tab 
 
Section 5.6.2 shows an example of the Tables option.  Section 5.6.3 shows an example of the Number 
Format option.  Section 5.6.4 shows an example of the Maximum Rows option. 
  



This publication is available free of charge from
: https://doi.org/10.6028/N

IST.AM
S.200-10 

 

 
 
 

   15 

4 Viewer 
 
SFA can generate views for part geometry, graphical PMI annotations, AP242 tessellated part geometry, 
and AP209 finite element models.  The views are shown in the default web browser using x3dom [26].  
The resulting view file is named myfile-sfa.html.  The HTML file is self-contained and can be shared 
with other users, including those on non-Windows systems, although an Internet connection is required.  
View examples are available at https://pages.nist.gov/CAD-PMI-Testing/.  The viewer does not support 
measurements. 
 
In the view, the origin of the model at '0 0 0' is shown with a small XYZ coordinate axis that can be 
switched off.  The background color can be changed between white, blue, gray, and black.  Depending on 
your web browser, the appearance of checkboxes and sliders might be different than what is shown in the 
figures below. 
 
Also in the view, use key 'a' to view all (+Y axis up) and 'r' to restore to the original view (+Z axis up).  
Sometimes the model might be located far away from the origin.  In this case, turn off the Origin and use 
'a' to view all.  The function of other keys is described in the link 'Use the mouse'.  Navigation uses the 
Examine Mode.  Use Page Up/Down to switch between perspective and orthographic projection modes.  
Navigation is easier in perspective mode. 

4.1 Part Geometry 
Figure 14 shows the part geometry view for a simple assembly.  Part edges are shown in black.  
Generating edges can be selected in the View section on the Options tab.  If only part geometry needs to 
be viewed, select View Only and Part Only in the Output Format section on the Options tab. 
 
On the right is the dimensions of the part bounding box.  The bounding box min and max XYZ 
coordinates are based on the faceted geometry being shown and not the exact geometry in the STEP file.  
There might be a variation in the coordinates depending on the quality option described below.  The 
bounding box also accounts for any sketch geometry if it is displayed, but not graphical PMI and 
supplemental geometry. 
 
On the right is a list of checkboxes for the parts and/or assemblies in the model.  Switching parts and 
assemblies on and off is a work-in-progress.  Most assemblies and parts can be switched on and off 
depending on the assembly structure.  Some names in the list might have an underscore and number 
appended to their name.  Processing sketch geometry might also affect the list of names.  Some 
assemblies have no unique names assigned to parts, therefore there is no list of part names.  Names that 
use non-English characters might have different or missing characters or cause the viewer to crash. 
 
Nested assemblies are supported where one STEP file contains the assembly structure with external file 
references to individual assembly components that contain part geometry. 
 
Clicking on the model shows the part name (rod) in the upper left.  A small dot might be visible where the 
model was clicked.  The part name shown may not be in the list of assemblies and parts on the right.  The 
part might be contained in a higher-level assembly that is in the list. 
 
For very large STEP files, it might take several minutes to process the STEP part geometry.  The resulting 
HTML file also might several minutes to display in the web browser.  Select 'Wait' if the web browser 
prompts that it is running slowly when opening the HTML file. 
 

https://pages.nist.gov/CAD-PMI-Testing/
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Figure 14: Part geometry view 
 

Figure 15 shows the assembly with the rod-assembly switched off.  Figure 20 below shows an example of 
a longer Assembly/Part list on the right. 
 

 
 

Figure 15: Part geometry view with rod-assembly switched off 
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Figure 16 shows the assembly partially transparent by using the transparency slider bar.  Transparency is 
only an approximation as shown by the missing three red nuts and the bottoms of the three blue bolts on 
the right.  This limitation might cause parts inside assemblies to be invisible.  The approximation is due to 
how transparency is implemented in x3dom. 
 

 
Figure 16: Part geometry view with approximate transparency 

 
Figure 17 shows only the part edges of the completely transparent assembly. 
 

 
Figure 17: Part geometry view with edges only 
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4.1.1 Part Quality and Normals 
 
Three levels of part quality (low, normal, high) can be selected in the View section of the Options tab.  
Quality controls the number of facets used for curved surfaces.  For example, the higher the quality the 
more facets used around the circumference of a cylinder.  A part geometry view with low quality selected 
is shown in Figure 18.  The facets around the cylindrical surfaces are clearly visible.  Although the part 
geometry is always displayed with smooth shading, a discontinuity in the shading is also apparent.  Figure 
19 shows the same part with quality set to high and normals selected.  Normals improve the default 
smooth shading by explicitly computing surface normals and improves the appearance of curved surfaces.   
 

 
Figure 18: Part geometry view with low quality 

 

 
Figure 19: Part geometry view with high quality and normals 
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4.1.2 Sketch Geometry 
The white lines in Figure 20 are an example of sketch geometry that is usually created in a CAD system 
to aid in geometry modeling.  The option for sketch geometry is in the View section of the Options tab.  
Sketch geometry is not the same as supplemental geometry described below.  The assembly2 also has 
eight different types of parts that can be switched on and off.  The assembly without sketch geometry can 
be viewed at https://pages.nist.gov/CAD-PMI-Testing/simple-assembly.html. 
 

 
 

Figure 20: Part geometry view with sketch geometry 
 
  

 
2 https://smstestbed.nist.gov/tdp/mtc/ 

https://pages.nist.gov/CAD-PMI-Testing/simple-assembly.html
https://smstestbed.nist.gov/tdp/mtc/
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4.1.3 Supplemental Geometry 
Figure 21 shows a part with a lot of supplemental geometry including planes, lines, and coordinate 
systems.  Supplemental geometry is shown only if part geometry or graphical PMI is also viewed.  
Supplemental geometry is not associated with graphical PMI saved views. 
 
The following types of supplemental geometry and associated text are supported. 

• Coordinate System: red/green/blue axes or by axes color 
• Plane: blue transparent outlined square 
• Cylinder: blue transparent cylinder 
• Line/Circle/Ellipse: purple line/circle/ellipse 
• Point: black dot 
• Tessellated Surface: faces outlined in black 

 
Bounding edges for planes are ignored.  All bounded and unbounded planes are displayed with a fixed 
size.  Supplemental geometry is not the same as sketch geometry described above. 
 

 
 

Figure 21: Part with supplemental geometry 
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4.2 Graphical PMI 
Graphical PMI (PMI presentation) can be viewed by selecting the option in the View section of the 
Options tab.  STEP AP203, AP214, and AP242 support graphical PMI. 
 
Figure 22 shows the graphical PMI that corresponds to the annotations shown in Figure 49.  The view file 
contains the line segments defined by the polylines in column F of Figure 70.  In this example, each part 
of the graphical PMI is assigned a different color to help differentiate them from each other. 
 
There is a checkbox for the graphical PMI associated with saved view ‘MBD_0’.  In this case, there is 
only one saved view for the PMI.  The actual viewpoint for a saved view is not used. 
 

 
 

Figure 22: Graphical PMI 
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Multiple saved view graphical PMI will have multiple checkboxes as shown in Figure 23.  In this 
example the graphical PMI in each saved view is assigned a different color. 
 

 
 

Figure 23: Graphical PMI with multiple saved views 
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4.2.1 Datum Targets 
Datum targets are shown only if a spreadsheet is generated with analyze for semantic PMI selected in the 
Options tab and part geometry or graphical PMI is also viewed.  Figure 24 shows an example of a part 
with a rectangular datum target highlighted in red.  The graphical PMI also has a datum target symbol, C1 
in the circle, pointing to the datum target. 
 
There are two methods to represent and view the position, orientation, and dimensions of a datum target.  
For the first method, the position, orientation, and target length, width, and diameter are specified 
parametrically.  Point, line, circle, circular curve, and rectangle datum targets are supported.  A small 
coordinate axes is shown at the origin of a datum target except for point datum targets in addition to the 
datum target label. 
 
For the second method, the shape and location of arbitrarily shaped area and curve datum targets is 
specified with geometric entities.  Supported geometric entities, that lie in plane, are line, circle, trimmed 
curves, and faces bounded by lines, circles, or ellipses. If other geometric entities are used, then either the 
datum target will not be shown or some of the edges of the datum targets will be missing.  Datum targets 
defined by multiple types of curves and non-planar datum targets are not supported. 
 
Both types of datum targets are shown in red and can be switched on and off in the view.  Datum target 
feature geometry, also specified with geometric entities similar to the second method, is shown in green. 
 

 
 

Figure 24: Graphical PMI with a datum target 
 
  



This publication is available free of charge from
: https://doi.org/10.6028/N

IST.AM
S.200-10 

 

 
 
 

   24 

4.3 AP242 Tessellated Part Geometry 
Tessellated part geometry can be viewed by selecting the option in the View section of the Options tab.  
STEP AP242 supports tessellated part geometry, but not AP203 and AP214.  Figure 25 shows tessellated 
part geometry where each tessellated facet is outlined. 
 

 
 

Figure 25: AP242 tessellated part geometry 
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4.4 AP209 Finite Element Model 
The finite element model in a STEP AP209 file can be viewed by selecting the option in the View section 
of the Options tab.  Nodes, 1D elements, 2D elements, and 3D elements are shown along with the finite 
element mesh.  Viewing boundary conditions, loads, and displacements is also supported.  Viewing 
stresses and strains is not supported.  There might be insufficient memory for SFA to process very large 
finite element models. 
 
4.4.1 Finite Element Mesh 
Figure 26 shows the view of the finite element model (FEM) of an ultra-lightweight glider [8].  2D 
elements are cyan, 1D elements are magenta, nodes are blue, and the mesh is black.  To the right of the 
view are checkboxes for Nodes, Mesh, and 1D and 2D Elements.  The number of nodes and different 
element types are also listed. 
 

 
 

Figure 26: AP209 FEM of ultra-lightweight glider 
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Figure 27 shows the same FEM without the mesh where the magenta-colored 1D elements are visible 
because the 2D elements are partially transparent.  Figure 28 shows only the nodes of the same FEM. 
 

 
 

Figure 27: AP209 FEM, no mesh 
 

 
 

Figure 28: AP209 FEM, nodes only 
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4.4.2 Boundary Conditions, Loads, and Displacements 
Figure 29 shows the AP209 FEM that is used to show boundary conditions, loads, and displacements.  
Options to control how they are viewed are on the Options tab. 
 

 
 

Figure 29: AP209 FEM 
 
 
Table 1 shows the icons used for constrained degrees-of-freedom (DOF).  Different types of icons can be 
combined for the appropriate DOF. 

 
Table 1: Icons for constrained DOF 

 
Degree-of-freedom Icon 
All six DOF Gray box 
All three translation DOF Gray pyramid 
All three rotation DOF Gray sphere 
Single translation DOF Red (x), green (y), or blue (z) 

line along the constrained 
translation DOF axis 

Single rotation DOF Red (x), green (y), or blue (z) 
circle around the constrained 
rotation DOF axis 
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Figure 30 shows some of the nodal boundary conditions for the FEM in Figure 29.  All rotation (gray 
spheres) and Z translation (blue vertical lines) DOF are constrained for all nodes.  Nodes along the X and 
Y axis are constrained in Y (green lines) and X (red lines) DOF, respectively. 
 

 
Figure 30: AP209 nodal boundary conditions 

 
Figure 31 shows nodal load vectors that are colored and scaled by the magnitude of the load.  The vectors 
can also be shown with constant length.  In this example there is only one load case.  The color scale 
shows the value of the loads. 
 

 
Figure 31: AP209 nodal load vectors 
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Figure 32 shows nodal displacement vectors that are colored and scaled by the magnitude of the 
displacement.  The color scale shows the value of the displacements.  The finite element mesh is not 
displaced. 
 

 
 

Figure 32: AP209 displacement vectors 
 
Figure 33 shows the displacements for one of ten mode shapes of a connecting rod. 
 

 
 

Figure 33: AP209 mode shape displacements 
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5 Spreadsheets 
 
Typical STEP file viewers show a 3D view of the part or model represented by the STEP file.  The 
viewers usually have a high-level hierarchical display of the assembly structure in the STEP file where 
you can drill down to individual attributes of parts.  However, there is no way to view all of the actual 
STEP entities and their attributes at once. 
 
SFA provides this capability by creating a spreadsheet from the STEP file.  The spreadsheet generated by 
SFA contains several worksheets.  There are Summary and Header worksheets, along with a worksheet 
for each entity type that was processed from the STEP file.  Links to sample worksheets are in the 
Examples menu. 

5.1 Summary Worksheet 
A Summary worksheet is shown in Figure 34.  Rows 1-6 contain basic information about the STEP file 
including a link to documentation for the schema used in the file.  Starting with row 9, each row in 
column A is the name of an entity processed from the STEP file.  The entity names are linked to their 
corresponding worksheet.  Column B is the number of each entity type. 
 

 
 

Figure 34: Summary worksheet 
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At the bottom of the spreadsheet are tabs for the Summary, Header, and many entity worksheets.  Entities 
in column A and in the worksheet, tabs are grouped, ordered, and colored according to the categories of 
entities in the Process section of the Options tab.  Selecting a tab, using the links in column A, or using 
the Control-PageUp and Control-PageDown keys will switch to a different worksheet. 

5.2 Header Worksheet 
A Header worksheet is shown in Figure 35.  Rows 3-11 contain the information in a STEP file header 
section.  Rows 1 and 2 are the STEP file name and directory. 
 

 
 

Figure 35: Header worksheet 
 

5.3 Entity Worksheets 
An entity worksheet is generated for each entity type shown on the Summary worksheet above.  The 
following example relates entities in a STEP file to the resulting worksheet generated by SFA.  Six 
datum_system entities from a STEP file are shown in Figure 36.  The entity ID is the number before the 
equal sign.  Values between the outermost parentheses are attribute values that are separated by commas.  
There are several different types of attributes including strings delimited by quote marks, references to 
other entity IDs (numbers preceded by #), boolean values (.T.), and null values ($). 
 

 
 

Figure 36: datum_system entities 
 
The resulting datum_system entity worksheet is shown in Figure 37.  Row 1 contains the name of the 
entity and the number of entities.  It is also a link back to the Summary worksheet.  Row 3 is the names of 
the entity attributes.  Column A is the entity ID. 
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Starting with row 4, each row contains the attribute values for an entity.  Column B is the text string for 
the name attribute.  Column C is the description attribute which is blank as indicated by the dollar sign 
above.  Column D is the of_shape attribute where, in this example, all of the values for the entities are 
product_definition_shape 56.  This means that the of_shape attribute is a reference to the 
product_definition_shape entity with an ID of 56 as shown above.  In column F, the constituents 
attribute refers to either single or multiple datum_reference_compartment entities.  The number in 
parentheses is the number of entity references and the numbers after the entity name are the entity IDs 
that are referenced. 
 

 
 

Figure 37: Entity worksheet (datum_system) 
 
In the draughting_model entity worksheet, shown in Figure 38, cells C4 and C6 refer to multiple entity 
types.  Cell C5 refers to multiple styled_item entities, however, the entity IDs are not shown because 
there are too many entity IDs to fit in one worksheet cell. 
 

 
 

Figure 38: Entity worksheet (draughting_model) 
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5.4 Skipped Attributes 
Sometimes SFA skips some specific types of entity attributes due to limitations of the IFCsvr toolkit.  A 
message about skipping an entity attribute will be shown in the Status tab and question marks are shown 
in the worksheet.  Figure 39 shows question marks (???) in column E where the control_points_list 
attributes were skipped. 
 

 
 

Figure 39: Entity worksheet (b_spline_surface_with_knots) 

5.5 Unicode Characters 
Text strings in STEP files can use Unicode characters [5].  However, SFA only supports Unicode 
characters using the \X\ and \S\ encoding.  For example, \X\E9 represents the character é.  However, the 
\X2\ and \X4\ encodings are not supported.  Non-English characters in text strings, that are not Unicode, 
might have different or missing characters. 

5.6 Options 
5.6.1 Inverse Relationships 
In a STEP schema, an entity attribute whose value consists of entity references, in which the referenced 
entity has attributes referring to the referencing attribute’s entity is called an inverse attribute.  This 
establishes an inverse relationship [27] that is explicitly defined in a STEP schema. 
 
Figure 40 is an entity worksheet for shape_aspect_relationship that shows the entity relationships 
established between the attribute values for relating_shape_aspect and related_shape_aspect in columns 
D and E. 
 

 
 

Figure 40: Entity worksheet (shape_aspect_relationship) 
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Figure 41 and Figure 42 show how inverse relationships are shown on the datum entity based on 
shape_aspect_relationship shown above..  Column G shows the relationship between datum and other 
entities.  Column H, with the Used In header, shows where datum is referred to from other entity 
attributes although not by an inverse relationship established by a STEP schema.  The tooltip in the 
Options tab for the Inverse Relationships selection shows the list of entities for which some attributes 
with Inverse and Used In relationships that are reported. 
 

 
 

Figure 41: Inverse Relationships and Used In example (columns A-F) 
 
 

 
 

Figure 42: Inverse Relationships and Used In example (columns G-H) 
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5.6.2 Tables 
Figure 43 shows the shape_aspect worksheet with the option for generating tables selected.  With this 
option, pull-down menus (selector on the right of each cell in row 3) are shown with the column headers 
in row 3 that access functions to sort and filter the rows.  The table is sorted by the name attribute in 
column B.  This is evident by the non-numerical default ordering of the entity IDs in column A.  The 
worksheet containing validation properties (section 6.3) is always sorted. 
 

 
 

Figure 43: Entity worksheet (shape_aspect) with tables for sorting 
 

5.6.3 Number Format 
By default, when a single real number is written to a worksheet cell, Excel might round the number.  
Figure 44, on the left, shows values of radius in column D that are rounded.  Using the Number Format 
option in the Spreadsheet tab to not round real numbers, results in the radius column is shown with full 
precision in the worksheet on the right.  The non-rounded real numbers are the actual values that appear 
in a STEP file.  The non-rounded real numbers are indicated by the small green triangle in the upper left 
corner of a cell.  The non-rounded real numbers are also left justified as opposed to the rounded real 
numbers that are right justified.  Real numbers that appear in pairs or triplets, such as cartesian points, are 
never rounded. 
 

 
 

Figure 44: Rounding numbers example 
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5.6.4 Maximum Rows 
The maximum rows option in the Spreadsheet tab limits the maximum numbers of rows in any 
spreadsheet or CSV file to the selected value.  This reduces the size of the spreadsheet and speed 
processing of the STEP file.  Figure 45 shows that only the first 100 of 43681 rows for the 
cartesian_point entities are written to the worksheet.  Syntax errors (section 6.4) related to reports might 
be missed if some entities are not processed due to a small value for maximum rows. 
 

 
 

Figure 45: Maximum rows example 
 

5.7 Anchor Section 
ISO 10303 Part 21 Edition 3 [24] is a new version of Part 21 that supports anchor, reference, and 
signature sections in a STEP file.  The anchor section can be used to assign a globally unique ID (GUID) 
to a specific entity.  Figure 46 shows the ANCHOR section in a STEP file which appears after the 
HEADER section and before the DATA section. 
 

 
 

Figure 46: ANCHOR section in a STEP file 
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Figure 47 shows the ANCHOR section worksheet corresponding to the STEP file above. 
 

 
 

Figure 47: ANCHOR section worksheet 
 
Figure 48 shows the ANCHOR IDs associated with the datum entities.  ANCHOR IDs are also reported 
on the PMI Representation Summary worksheet (section 6.1.6).  GUIDs can also be assigned to entities 
with the id_attribute entity. 
 

 
 

Figure 48: ANCHOR ID reported on datum worksheet 
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6 Analysis Reports 
 
The analysis reports check the STEP file against recommended practices are defined by the CAx 
Interoperability Forum (CAx-IF) [23, 25].  The objective of the CAx-IF is to advance CAx (mainly 
Computer-Aided Design, Engineering, and Manufacturing) software system translator development and 
to ensure that user requirements for interoperability are satisfied.  Three different reports can be created. 
 

1. PMI Representation (semantic PMI) described in section 6.1 
2. PMI Presentation (graphical PMI) described in section 6.2 
3. Validation Properties described in section 6.3 

 
Product and manufacturing information (PMI) are annotations and attributes that define product geometry 
and product specifications [28].  PMI includes 3D annotations to specify Geometric Dimensioning and 
Tolerancing (GD&T), as well as non-geometric data such as surface texture specifications, finish 
requirements, process notes, material specifications, and welding symbols.  GD&T is a symbolic 
language used to communicate tolerances on manufactured parts.   The industry standards for presentation 
of GD&T in axonometric views in 3D space are ASME Y14.41-2003 [29] and ISO 16792:2006 [30].  
Some common tolerances include dimensional tolerances on length and diameter, and geometric 
tolerances on flatness, position, surface profile, and circular runout. 
 
Figure 49 shows NIST test case CTC 33 with typical feature control frames (FCF) with PMI annotations 
including dimensions, geometric and dimensional tolerances, and datum features.  Most of these types of 
annotations are processed by SFA. 
 

 
3 https://s3.amazonaws.com/nist-el/mfg_digitalthread/nist_ctc_03_asme1_rc.pdf 

https://s3.amazonaws.com/nist-el/mfg_digitalthread/nist_ctc_03_asme1_rc.pdf
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Figure 49: NIST test case CTC 3 
 
Figure 50 shows the summary worksheet, similar to Figure 34, with entities highlighted that have 
information related to PMI Representation and PMI Presentation.  Rows 10-13 are entities related to the 
datum reference frame.  Row 14 is the dimensional_characteristic_representation entity which is 
associated with all dimensional tolerances.  Rows 9 and 17-27 are entities related to geometric tolerances.  
Row 28 is the annotation_curve_occurrence entity which is associated with PMI presentation.  The 
entity name in parentheses in cell A17 is for a complex entity 
(flatness_tolerance)(geometric_tolerance_with_defined_unit_area).  All of the worksheets for the 
highlighted entities will have additional columns with PMI information related to that type of entity. 
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Figure 50: Summary worksheet with entities highlighted for PMI 

6.1 PMI Representation 
PMI representation (also known as semantic PMI) includes all information necessary to represent GD&T 
without any graphical presentation elements.  PMI representation is associated with CAD model geometry 
and is computer-interpretable to facilitate automated consumption by downstream applications for 
manufacturing, measurement, inspection, and others.  PMI representation does not contain any 
information regarding its visual appearance although an importing CAD system can attempt to recreate 
the visual presentation of the annotation.  The CAx-IF defines recommended practices for PMI 
representation [31].  Syntax errors related to nonconformance to the recommended practices are 
highlighted in red in the Status tab and in the relevant entity worksheets (section 6.4). 
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6.1.1 Visual Presentation of PMI Representation 
Sections 6.1.2 through 6.1.4 show three examples of how PMI representation is reported.  The report 
includes a visual presentation of the semantic PMI information that can be used for visual verification of 
that information.  The visual presentation is based only on the semantic PMI and not on the graphical 
PMI.  The visual presentation should correspond to the expected PMI annotations similar to those on 
Figure 49.  If the visual presentation does not look right, then the semantic PMI information might be 
wrong.  The visual presentation is limited by the characters and symbols available in the spreadsheet.  
Section 6.5.1 has examples of problems with the visual presentation of the PMI representation.   
 
6.1.2 Datum Reference Frame 
The following figures show how a datum reference frame is modeled in a STEP file.  Figure 51 shows the 
datum worksheet that defines the datum labels in column F.   
 

 
 

Figure 51: Entity worksheet (datum) 
 
Figure 52 shows the datum_reference_compartment worksheet with information for the compartments 
of a datum reference frame.  The compartments are constructed from the base attribute that refers to the 
datum entity above and the modifiers attribute.  The visual presentation of the compartments is shown in 
column H.  The parenthetic notation in cell H3 specifies the section number in the CAx-IF recommended 
practice for PMI representation related to that information [31].   
 

 
 

Figure 52: Entity worksheet (datum_reference_compartment) 
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Figure 53 shows the datum_system worksheet with information to combine the datum reference 
compartments, defined by the constituents attribute, to create a datum reference frame.  The visual 
presentation of the datum reference frames is shown in column G.   
 

 
 

Figure 53: Datum reference frame example 
 
6.1.3 Dimensional Tolerance 
The following example shows how a dimensional tolerance is modeled in a STEP file.  Figure 54 and 
Figure 55 show the dimensional_characteristic_representation worksheet where information related to 
dimensional tolerances is reported.   
 

• Column B is the type of dimension, either dimensional_size or dimensional_location. 
• Column C is a reference to shape_dimension_representation which refers to information for the 

dimension name and value. 
• Column D shows the visual presentation of the dimensional tolerances that correspond to the PMI 

annotations in Figure 49. 
• Column E shows the name attribute of the entity type shown in column B.   
• Column F shows the dimension (length value) associated with the 

shape_dimension_representation entity in column C.   
• Column G shows the name of the length value in column F.   
• Column H shows the plus-minus bounds associated with the dimensional tolerance.  The bounds 

are defined by plus_minus_tolerance entities. 
• Column I shows the geometric entities associated with the dimensional tolerances.  In this case, 

the association is through shape_aspect entities which refer to advanced_face entities.  The 
geometry entities cylindrical_surface and plane are referred to by the advanced_face attribute 
face_geometry. 

• Section 6.1.5 explains how associated geometry is important to relate dimensional tolerances with 
geometric tolerances and datum features. 

• More columns may show other attributes of dimensional tolerances. 
 

The parenthetic notation in row 3 specifies the section number in the CAx-IF recommended practice for 
PMI representation related to that piece of information.  For example, recommended practice sections 
5.1.1 (column E) and 5.2.1 (column G) specify allowable attribute values shown in those columns. 
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Figure 54: Dimensional tolerance example (columns A-C) 
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The visual presentation in Figure 55 can be used to do a semantic analysis of the PMI representation 
information.  The dimension ‘0.75’ in cell D11 appears as a reference dimension ‘(.750)’ in Figure 49.  In 
this case, the STEP file is missing the dimension modifier for a reference dimension.  The visual 
presentation of the dimension shows that parentheses for a reference dimension are missing. 
 
The feature count for a repetitive dimension, e.g., ‘4X’ and ‘2X’, in cells D6 and D7, respectively, are 
derived from the number of geometric surfaces in the associated geometry in column I.  In this example, 
the feature count is half the number of cylindrical_surface entities in cells I6 and I7.  This assumes that a 
cylindrical hole is modeled with two half cylindrical surfaces. 
 

 
 

Figure 55: Dimensional tolerance example (columns A, D-I) 
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6.1.4 Geometric Tolerances 
The following examples show how geometric tolerances are modeled in a STEP file.  Figure 56 and 
Figure 57 show the flatness_tolerance worksheet with the reconstructed visual presentation for the 
flatness tolerance. 
 

• Column D is the magnitude of the flatness tolerance zone which is a reference to a 
length_measure_with_unit.  As a convenience, the value of the length measure “0.005” is also 
shown. 

• Column E is a reference to the toleranced shape_aspect. 
• Columns F and G define the unit-basis size and type for the flatness tolerance.  Another unit-basis 

parameter in column H is not shown. 
• Column I shows the visual presentation of the FCF for the flatness tolerance with the 

corresponding unit-basis and datum feature. It corresponds to the PMI annotations in Figure 49. 
• Column J is the datum feature associated with the flatness tolerance. 
• Column K shows the toleranced geometry associated with the flatness tolerance derived from the 

toleranced_shape_aspect attribute in column E. The advanced_face entity references the plane 
entity. 

• Section 6.1.5 explains how toleranced geometry is important to relate geometric tolerances with 
dimensional tolerances and datum features. 

 
The reconstructed visual presentation of the PMI representation is limited by the character set available in 
the spreadsheet.  The flatness tolerance symbol (parallelogram) appears somewhat small and misshapen.  
The lines for the compartments of the feature control frame are not shown.  The combination of the 
inverted triangle, vertical line, and ‘E’ in brackets represents the reference to datum feature ‘E’. 
 

 
 

Figure 56: Flatness tolerance example (columns A-H) 
 
 

 
 

Figure 57: Flatness tolerance example (columns I-K) 
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Figure 58 and Figure 59 show the position_tolerance worksheet with the reconstructed visual 
presentations of two position tolerances. 
 

• Column D is the magnitude of the position tolerance zone.  As a convenience, the value of the 
length measure “0.005” is also shown. 

• Column E is a reference to the toleranced shape_aspect. 
• Column F is a reference to the associated datum reference frame. 
• Column G is the modifier applied to the tolerance zone. 
• Column H shows the visual presentation of the position tolerances with their associated 

dimensions.  An association between a geometric tolerance and dimension (or datum) is shown if 
each has the identical cylindrical_surface entities in the geometric tolerance Toleranced Geometry 
(Figure 59, Column J) and dimension Associated Geometry (Figure 55, cells I6 and I7).  

• Column I shows the FCF of the dimensional tolerance, defined in Figure 55, associated with the 
position tolerance.  The dimensional_size entities are referred to in column B of Figure 54.    

• Column J shows the geometry, defined by the toleranced_shape_aspect attribute in column E, 
associated with the position tolerance. 

• Section 6.1.5 explains how toleranced geometry is important to relate geometric tolerances with 
dimensional tolerances and datum features. 

 

 
 

Figure 58: Position tolerance example (columns A-G) 
 
 

 
 

Figure 59: Position tolerance example (columns H-J) 
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6.1.5 Associated and Toleranced Geometry 
The previous examples for dimensional and geometric tolerances show columns for associated and 
toleranced geometry.  The relationship between the geometries is important to understand how the visual 
presentation of the feature controls frames (FCF) in Figure 57 and Figure 59 are constructed.  Figure 60 
shows one of the position tolerances from Figure 49 where the FCF contains a position tolerance, hole 
dimension, and datum feature. 
 

 
 

Figure 60: Position tolerance feature control frame 
 
Cell G4 in Figure 61 shows the visual presentation of the FCF based on the position tolerance, dimension 
tolerance, and datum feature.  The key to the visual presentation is that all three components of the FCF 
refer to the same geometric entities.  The toleranced geometry for the position tolerance in cell J4 should 
be read from bottom to top.  The composite_group_shape_aspect (CGSA) entity is from the 
toleranced_shape_aspect attribute on the position_tolerance entity.  CGSA refers to two shape_aspect 
entities.  Those two entities each refer to a single advanced_face entity which each refer to a 
cylindrical_surface entity.  The two cylindrical_surface entities (#23831, #23941), highlighted in red, are 
the two half cylinders for the surfaces of the hole.  Sometimes there is only one cylindrical_surface for a 
hole as described in section 6.1.5. 
 

 
 

Figure 61: Toleranced geometry for position tolerance 
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Cell K5 in Figure 62 shows the associated geometry for the dimension tolerance in cell D5.  Although the 
CGSA and shape_aspect entities are different than those in cell J4 of Figure 61, the advanced_face and 
cylindrical_surface (#23831, #23941) entities are identical.  Therefore, the position and dimension 
tolerance are both associated with the same hole geometry.  The associated geometry for dimensions is 
found through the applies_to attribute on dimensional_size and the relating_shape_aspect and 
related_shape_aspect attributes on dimensional_location. 
 

 
 

Figure 62: Associated geometry for dimensional tolerance 
 
Cell G5 in Figure 63 shows the associated geometry for datum feature ‘C’.  In this case, the 
datum_feature entity refers directly to the advanced_face entities.  Therefore, the datum feature is also 
associated with the same hole as the position and dimension tolerance.  The datum feature is also directly 
associated with the position tolerance because the position_tolerance entity is a complex entity with 
geometric_tolerance_with_datum_reference that refers directly to the datum feature. 
 

 
 

Figure 63: Associated geometry for datum feature 
 
If an expected association between a geometric tolerance and a dimension or datum is not reported, then 
the associated geometry and toleranced geometry for each tolerance, dimension, and datum should be 
checked.  A common problem is a position tolerance for a hole being associated with the surfaces of the 
hole cylinder and the corresponding hole diameter dimension only being associated with the circular edge 
of the hole and the hole surfaces. 
 
In Figure 49 datum feature ‘E’ is associated with a surface profile tolerance.  Datum feature ‘E’ is the 
surface of the tab.  However, in Figure 67, datum feature ‘E’ is associated with two geometric tolerances 
shown in cells C21 and C28.  Semantically both are correct since both tolerances refer to the same 
surface.  There is no semantic information in the STEP file to specify which tolerance the datum feature is 
presented with.   
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6.1.5.1 Multiple Dimensions 
In some cases, multiple dimensions might be associated with the same geometric entities.  Figure 64 
shows the warning message when multiple dimensions are detected.  Cells D9 and D10 in Figure 65 show 
the multiple dimensions.  In this example, there are two diameter dimensions with and without a tolerance 
value.  Cells K9 and K10 in Figure 66 show the associated geometry for each dimension where they are 
both associated with the same cylindrical_surface entities (#10546, #10656).  Multiple dimensions might 
also be reported for holes that have a counterbore, countersink, and depth. 
 

 
 

Figure 64: Warning message for multiple dimensions 
 
 

 
 

Figure 65: Multiple dimensions example (columns D-H) 
 
 

 
 

Figure 66: Multiple dimensions example (column K) 
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6.1.6 PMI Representation Summary 
As a convenience, all of the visual presentations of the datum reference frames, dimensional tolerances, 
and geometric tolerances are collected on the PMI Representation Summary worksheet shown in  
Figure 67.  The annotations in column C are collected from column G in Figure 53, column D in  
Figure 55, column I in Figure 57, and column H in Figure 59.  The annotations in column C correspond to 
the annotations shown in Figure 49. 
 

 
 

Figure 67: PMI Representation Summary worksheet 
 
If a STEP file that was generated from a NIST CAD model from the MBE PMI Validation and 
Conformance Testing Project [32] is processed and the file can be recognized as having been generated 
from one of the CAD models, then the PMI Representation Summary worksheet is color-coded by the 
expected PMI annotations (section 6.5.1).  
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6.1.7 PMI Representation Coverage Analysis 
Coverage analysis counts the number of occurrences of a PMI element in a STEP file.  Figure 68 shows 
the worksheet that is generated for coverage analysis of PMI Representation.  Column A in rows 4 
through 26 contain different types of PMI elements related to geometric and dimensional tolerances.    
Tolerances and modifiers show their associated symbol.  The numbers in parentheses refer to the sections 
in the CAx-IF recommended practice for the representation of PMI [31] where there is implementation 
guidance for that type of PMI element. 
 
Column B contains the number of occurrences of that type of PMI element in the file.  Comparing the 
count to the number of expected PMI elements is a way to verify the PMI in the STEP file and resolve 
and modeling issues.  If a STEP file that was generated from a NIST CAD model is processed, then the 
PMI Representation Coverage worksheet is color-coded by the expected number of PMI elements 
(section 6.5.2). 
 

 
 

Figure 68: PMI Representation Coverage worksheet 



This publication is available free of charge from
: https://doi.org/10.6028/N

IST.AM
S.200-10 

 

 
 
 

   52 

Table 2 shows the complete list of PMI Elements that can appear in column A above.  Tolerances and 
modifiers show their associated symbol.  The numbers in parentheses refer to the sections in the CAx-IF 
recommended practice for the representation of PMI. 
 

Table 2: All PMI Elements for PMI Representation Coverage 
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6.2 PMI Presentation 
PMI presentation (also known as graphical PMI) presents GD&T annotations as a visual representation of 
geometric elements such as lines and arcs as part of the CAD model, i.e., how the annotation is drawn on 
the model.  PMI presentation is not intended to be computer-interpretable and does not carry any semantic 
representation information although it can be linked to its corresponding semantic representation. The 
CAx-IF defines recommended practices for PMI presentation [31].  Syntax errors related to 
nonconformance to the recommended practices are highlighted in red in the Status tab and in the relevant 
entity worksheets (section 6.4). 
   
Figure 69 through Figure 71 show how PMI presentation is reported in the spreadsheet.  The report for 
PMI presentation only contains information about the graphical elements (points, lines, colors) needed to 
draw PMI annotations.  PMI presentation information is always reported on the 
annotation_curve_occurrence (as in this example), tessellated_annotation_occurrence, or 
annotation_occurrence worksheets. 
 

• Columns B, C, and D show the entity attributes. 
• Column E shows the name attribute of the geometric_curve_set in column D.   
• Column F shows the element attributes of the geometric_curve_set.  In this case, the elements 

refer to polyline entities.   
• Column G shows the curve_style associated with the presentation_style_assignment in column 

C.   
• Column H shows the color associated with the curve_style in column G. 
• Column I shows the annotation plane associated with the annotation.   
• Column J shows the geometry that the annotation is attached to.  If associated geometry is 

missing, then there is no cross-highlighting between the annotation and geometry. 
• Column K shows the associated PMI representation entities. 
• Not shown are columns for PMI presentation validation properties and Saved Views. 

 

 
 

Figure 69: PMI presentation example (columns A-D) 
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Figure 70: PMI presentation example (columns E-H) 
 
 

 
 

Figure 71: PMI presentation example (columns I-K) 
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6.2.1 PMI Presentation Coverage Analysis 
Coverage analysis counts the number of occurrences of a PMI element in a STEP file.  Figure 72 shows 
the worksheet that is generated for coverage analysis of PMI presentation.  Rows 4 through 35 of column 
A contain the recommended names [31] that can be associated with a PMI annotation.  The names 
correspond to the values in column E in Figure 70.  There is no semantic meaning associated with the 
names.  PMI presentation assumes a semantic meaning through its association with PMI representation as 
shown in column K of Figure 71. 
 

 
 

Figure 72: PMI Presentation Coverage worksheet 



This publication is available free of charge from
: https://doi.org/10.6028/N

IST.AM
S.200-10 

 

 
 
 

   56 

6.3 Validation Properties 
Validation properties are an important tool to verify the information in a STEP file.  The properties 
include geometric, PMI, assembly, annotation, attribute, and tessellated validation properties.  For 
example, geometric validation properties are characteristics of solid and surface models, such as area, 
volume, and centroid.  Geometric validation properties could be written to a STEP file when it is exported 
from a CAD system.  When the STEP file is imported to a receiving CAD system, that system can 
compute the same validation properties and compare them to the values from the originating system in the 
STEP file.  If the computed validation properties are within an agreed tolerance to the original validation 
properties, then the exchange of geometric information has been validated. The CAx-IF defines 
recommended practices for validation properties [33].  Syntax errors related to nonconformance to the 
recommended practices are highlighted in red in the Status tab and in the relevant entity worksheets 
(section 6.4). 
 
Figure 73 and Figure 74 shows a validation properties report.  The report always appears on the 
property_definition worksheet.  The rows can be sorted by any of the column attributes.  The validation 
properties are shown in the yellow and green columns E, G, I, K, and M.  Row 3 contains the names of 
the type of value in those columns.  Properties not colored yellow and green are not validation properties 
as defined by the recommended practice.  The values in cells I7, I10, and I16 are cartesian coordinates.  
Empty cells E13 and E14 show that values for those attributes were not specified in the STEP file.  If no 
values for units and exponent appear in rows K and M, then none are required based on the type of value 
in row I. 
 
The hidden columns F, H, J, L, and N can be shown by clicking on the plus (+) signs above the columns 
or the “2” in the upper left corner.  Those columns contain the entity attribute name and ID for the 
corresponding validation property value in the column to the left.  Opening the hidden columns shows 
where the validation property values come from in the STEP file.  The hidden columns F, H, and J are 
shown in Figure 75.  Columns L, M, and N are not shown.  For example, the value in cell G4 “surface 
area measure” comes from the measure_representation_item name attribute of entity ID 393.  The 
expanded columns can be hidden again by clicking on the minus (-) signs above the columns or the “1” in 
the upper left corner. 
 

 
 

Figure 73: Validation properties example (columns A-D) 
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Figure 74: Validation properties example (columns E-O) 
 
 

 
 

Figure 75: Validation properties example with expanded columns (columns E-J) 
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6.4 Syntax Errors 
Syntax errors, related to nonconformance to a CAx-IF recommended practice, are highlighted in red in 
the Status tab and on the relevant entity worksheets.  Figure 76 shows a syntax error displayed in the 
Status tab associated with an annotation_curve_occurrence entity while generating the PMI Presentation 
report.  The second line of the syntax error refers to specific sections, figures, or tables in the relevant 
recommended practice that provides the guidance for the correct implementation of that information.  
Figure 77 shows a warning message highlighted in yellow related to 
dimensional_characteristic_representation. 
 

 
 

Figure 76: Syntax error related to annotation_curve_occurrence 
 
 

 
 

Figure 77: Warning message related to dimensional_characteristic_representation 
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Entity types that have any syntax or warning messages are highlighted in gray on the Summary worksheet 
as shown in Figure 78.  The red triangle in the upper left corner of a cell indicates that there is a comment 
shown in the yellow box.  Entities with errors are also highlighted in red in the Status tab with the 
messages about Formatting Worksheets. 
 

 
 

Figure 78: Entities with errors or warnings highlighted on Summary worksheet 
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Figure 79 shows the (characterized_representation)(draughting_model) worksheet where the syntax 
errors from Figure 76 are highlighted in cells C4 and C5.  The comment is same text displayed in the 
Status tab in Figure 76.  Although the syntax error was detected when processing 
annotation_curve_occurrence entities, the actual error is related to the items attribute on the 
(characterized_representation)(draughting_model) entity. 
 

 
 

Figure 79: Syntax error on (characterized_representation)(draughting_model) 
 
Figure 80 shows the dimensional_characteristic_representation worksheet where the warning message 
from Figure 77 is shown with a comment for the cell in column L.  The comment means that the 
associated geometry for this hole diameter is an edge curve when a hole diameter would usually be 
associated with cylindrical surfaces.  
 

 
 

Figure 80: Warning message on dimensional_characteristic_representation 
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There are also some other explanatory comments for the headings in row 3 on several types of worksheets 
as shown in Figure 81. 
 

 
 

Figure 81: Cell comment for dimensional tolerances 
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6.5 Color-coding Results for NIST CAD Models 
If a STEP file is processed that was generated from a NIST CAD model from the MBE PMI Validation 
and Conformance Testing Project [32] and the file can be recognized as having been generated from one 
of the CAD models, then the PMI Representation Summary and PMI Representation Coverage 
worksheets are color-coded by the expected PMI annotations. 
 
6.5.1 Representation Summary 
The PMI Representation Summary worksheet is color-coded by the expected PMI annotations in a NIST 
test case drawing.  Figure 82 is a color-coded worksheet for a STEP AP242 file generated from CAD 
model based on NIST test case CTC 54.  A similar worksheet based on NIST test case CTC 3, without 
color-coding, is shown in Figure 67. 
 
The color-coding is determined by comparing the expected PMI annotations for a NIST test case, that are 
stored in SFA, with the PMI Representation generated by SFA in column C.  The comparison has nothing 
to do with the graphic PMI in the STEP AP242 file, only the semantic PMI. 
 
The legend at the bottom of column C describes the color-coding. 
 

• Green is an exact match to an expected PMI annotation in the NIST test case drawing. 
• Cyan is a partial match. 
• Yellow is a possible match. 
• Red is no match. 

 
For partial and possible matches, the best match to expected Similar PMI is shown in column D.  At the 
bottom of column C are the expected Missing PMI annotations not found in the STEP file.  The red 
triangles in the upper right corners of cells C3 and D3 indicate that there is a cell comment that explains 
the meaning of the cells in columns C and D. 
 
In this example, cell C14 is missing the diameter symbol for a hole dimension.  This means that the 
dimensional_characteristic_representation entity (#906) refers to a dimensional_location entity instead 
of a dimensional_size entity.  Dimensional_size should almost always be used for hole diameters.   
Cell D14 shows the expected Similar PMI, from the NIST test case drawing for the hole diameter, that 
includes the diameter symbol. 
 
Cell C15 is colored red because the reference dimension value ‘(2.500)’ found in the STEP file does not 
appear in the NIST test case drawing.  Conversely, the missing PMI in cells C33 and C34 show that those 
two basic dimensions are found in the NIST test case drawing but not in the STEP file.  
 
The shape of the placed datum targets in cells C18 and C19 are incorrect.  This means that the description 
attributes on the placed_datum_target_feature entities (#1103, #1104) are ‘point’ instead of ‘rectangle’. 

 
4 https://s3.amazonaws.com/nist-el/mfg_digitalthread/nist_ctc_05_asme1_rd.pdf  

https://s3.amazonaws.com/nist-el/mfg_digitalthread/nist_ctc_05_asme1_rd.pdf
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Figure 82: Color-coded PMI Representation Summary worksheet for CTC 5 
 
There are several problems with the total_runout_tolerance in cell C22.  Because there are more 
problems it is colored yellow as a possible match.  The magnitude of the tolerance zone is ‘.001’ instead 
of ‘.002’. 
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The feature control frame (FCF) for the similar PMI in cell D22 shows that there is a dimension tolerance 
and datum feature associated with the geometric tolerance.  Figure 83, from NIST test case drawing for 
CTC 5, shows a large inner diameter surface with the total runout tolerance.  That surface also has a 
diameter dimension that is defined as datum feature ‘B’.  Semantically, those three PMI elements all refer 
to the same large inner diameter surface in the test case drawing.  Therefore, the similar PMI in cell D22 
is also a correct visual presentation of the FCF for the PMI annotation.  Cell C22 is missing the diameter 
dimension and datum feature because the geometric tolerance is not associated with the same geometric 
surfaces as the diameter dimension and datum feature.  This can be confirmed by checking the toleranced 
or associated geometry for the total_runout_tolerance, the dimensional_characteristic_representation, 
and datum_feature.  The geometric tolerance must have the exact same toleranced or associated 
geometry to be able to show the FCF in cell C22 as it appears in cell D22.  The association of toleranced 
and associated geometry is described in section 6.1.5. 
 

 
Figure 83: Feature from NIST CTC 5 

 
The roundness_tolerance in cell C20 has the exact same associated geometry as datum feature ‘A’. 
therefore, the FCF appears correct and is colored green. 
 
Trailing and leading zeros are ignored when matching a PMI annotation to the expected PMI.  Matches 
also only consider the current capabilities of PMI in STEP AP242 and CAx-IF Recommended Practices.  
For example, PMI annotation symbols for counterbore, countersink, and depth are ignored although they 
might appear in the corresponding CAD model. 
 
Some causes of partial and possible matches are: 
 

• missing associations of a geometric tolerance with a datum feature or dimension 
• missing diameter and radius symbols 
• wrong feature counts for repetitive dimensions 
• wrong dimension or tolerance zone values 
• missing or wrong values for dimension tolerances 
• missing or wrong datum reference frames 
• missing datum features 
• missing or incorrect modifiers for dimensions, tolerance zones, and datum reference frames 
• missing composite tolerances 
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6.5.2 Representation Coverage Analysis 
The PMI Representation Coverage worksheet is color-coded by the expected number of PMI elements for 
a NIST test case.  The expected number of PMI elements was determined by manually counting them in 
each test case drawing, similar to Figure 49, for the NIST test cases.  The color-coded worksheet is shown 
in Figure 84.  A similar worksheet without color-coding is shown in Figure 68. 
 
If more or less than the expected number of PMI elements was found, then the first value of two is the 
number found and the second is the expected number.  For example, ‘2/3’ means that two PMI elements 
were found when three were expected.  Counting of some modifiers, e.g., maximum material condition in 
row 24, does not differentiate whether the modifier appears in the tolerance zone definition or datum 
reference frame. 
 
A legend describing the colors is in column D of Figure 84. 
 

• A green cell is a match to the expected number of PMI elements.   
• Cyan means that more were found than expected, e.g., ‘4/3’.   
• Yellow, yellow-green, and orange mean that less were found than expected, e.g., ‘2/3’. 
• Red means that no instances of an expected PMI element were found, e.g., ‘0/3’ 
• Magenta means that PMI elements were found when none were expected, e.g., ‘1/0’ 

 
In this example, there is one extra dimensional location (cell B13).  This is also apparent from cell B11 
which counts that total number of dimensions in cells B12 and B13.  Cell B24 shows that the saved view 
is missing. 
 
A cell color other than green might mean that a CAD system or translator 
 

• did not or cannot correctly create in the CAD model, a PMI element defined in a NIST test case, 
• did not follow CAx-IF Recommended Practices for PMI [31], 
• has not implemented exporting a PMI element to a STEP file, or 
• mapped an internal PMI element to the wrong STEP PMI element. 

 
Some of the NIST test cases have complex PMI annotations that are not commonly used.  There might be 
ambiguities in counting the number of PMI elements. 
 
6.5.2.1 Color-coding Expected PMI 
From the PMI Representation Summary results in Figure 82, color-coded percentages of exact, partial, 
and possible matches to Expected PMI and missing PMI is shown in a table below the PMI 
Representation Coverage Analysis in Figure 84 in rows 29 through 35. The Total PMI on which the 
percentages are based on is also shown.  Coverage Analysis is only based on individual PMI elements.  
The PMI Representation Summary is based on the entire PMI feature control frame and provides a better 
understanding of the PMI.  The Coverage Analysis might show that there is an exact match for all of the 
PMI elements, however, the Representation Summary might show less than exact matches. 
 
For example, if a STEP file has the correct number of dimensions, the dimension PMI elements will be 
colored green.  This does not mean that the dimension values are correct.  Those incorrect dimension 
values are not reflected in the PMI Coverage Analysis.  Incorrect values would show up as partial or 
possible matches in Figure 82.  Those partial or possible matches would show up in the second table in 
Figure 84. 
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Figure 84: Color-coded PMI Representation Coverage worksheet 
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7 Syntax Checker 
 
The Syntax Checker checks for basic syntax errors and warnings in the STEP file related to missing or 
extra attributes, incompatible and unresolved entity references, select value types, illegal and unexpected 
characters, and other problems with entity attributes.  Some errors might prevent SFA and other software 
from processing a STEP file. 
 
There should not be any of these types of syntax errors in a STEP file.  Errors should be fixed to ensure 
that the STEP file conforms to the STEP schema and can interoperate with other software.  There are 
other validation rules defined by STEP schemas (where, uniqueness, and global rules, inverses, derived 
attributes, and aggregates) that are not checked.  Conforming to the validation rules is also important for 
interoperability with STEP files. 
 
The Syntax Checker can be run with function key F8 or when a Spreadsheet or View is generated.  The 
Status tab might be grayed out when the Syntax Checker is running.  The Syntax Checker works with any 
supported STEP schema. 
 
Syntax checker results appear in the Status tab.  If the Log File option is selected, the results are also 
written to a log file myfile-sfa-err.log.  The syntax checker errors and warnings are not reported in the 
spreadsheet.  If errors and warnings are reported, the number in parentheses is the line number in the 
STEP file where the error or warning was detected. 
 
Syntax Checker errors and warnings are unrelated to those reported when CAx-IF Recommended 
Practices are checked with one of the Analyze options as described in section 6.4. 
 

 
 

Figure 85: Syntax Checker results 
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8 Multiple STEP Files 
 
Processing multiple STEP files at once is an easy way to process many STEP files with only a few mouse 
clicks and to compare entity usage and coverage of PMI representation and presentation across multiple 
STEP files. 
 
There are two ways you can select multiple STEP files.  The first is to use the  
Open Multiple STEP Files in a Directory option from the File menu as shown in Figure 4.  You can select a 
directory in which all STEP files in that directory will be processed.  Subdirectories of the selected 
directory can also be searched.  The other way is to select multiple individual STEP files when using the 
Open STEP File(s) option from the File menu.  Multiple STEP files can be selected in the Open File(s) 
dialog by holding down the control or shift key when selecting files. 

8.1 Summary Worksheet 
When processing multiple STEP files, a second spreadsheet is generated in addition to the individual 
spreadsheets for each STEP file.  The second spreadsheet contains a summary worksheet of the entities 
found in the multiple files and possible coverage worksheets for PMI representation and presentation as 
shown in Figure 86.  In this example five STEP files were processed.  Starting after row 9, column A lists 
all of the entity types in all five files.  All of the entities (rows) are not shown.  The entities in column A 
are grouped and colored according to the categories of entities in the Process section of the Options tab.  
Columns B through F contain the entity counts for each of the five STEP files.  Column G is the total 
entity count for all of the files and column H is the total number of files that an entity appears in. 
 
Row 1 is the top-level directory where all of the STEP files are located.  Row 3 contains links to the 
individual spreadsheets.  Row 4 contains the name of the STEP file and a link to it.  The file name can 
also contain the file’s subdirectory.  Clicking on the STEP file link will show it in whatever program is 
set to open STEP files (.stp file extension) on your computer.  The links in rows 3 and 4 can be turned off 
in the Spreadsheet tab with the selections for Excel Options.  Rows 5 through 9 contain, respectively, the 
file timestamp, software that generated the STEP file (blank in this example), the STEP AP from the file, 
the size of the STEP file, and the number of entities in the STEP file. 
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Figure 86: File Summary worksheet, multiple files (rows 31-56) 
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8.2 Coverage Analysis Worksheets 
If PMI representation or presentation is found in the STEP file, then coverage analysis worksheets are 
generated. 
 
8.2.1 PMI Representation Coverage Analysis 
Figure 87 shows the worksheet that is generated for coverage analysis of PMI representation.  The 
information on the worksheet is the same as described in section 6.1.7.  Columns B through F refer to five 
STEP files and contain the number of occurrences of that PMI element.  Column G counts the total 
number of occurrences for all STEP files that contain that type of PMI element.  In this example the cells 
are color-coded, as described in section 6.5, because all five STEP files were generated from the NIST 
CAD models. 
 

 
 

Figure 87: PMI Representation Coverage worksheet, multiple files (rows 1-33) 
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Figure 88: PMI Representation Coverage worksheet, multiple files (rows 34-61) 
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8.2.2 PMI Presentation Coverage Analysis 
Figure 89 shows the worksheet that is generated for coverage analysis of PMI presentation.  The 
information in the worksheet is the same as described in section 6.2.1.  Columns B through F refer to five 
STEP files and contain the number of occurrences of that PMI presentation name.  Column G counts the 
total number of occurrences for all STEP files that contain that name. 
 

 
 

Figure 89: PMI Presentation Coverage worksheet, multiple files  
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9 Command-line Version 
 
A command-line (console) version of SFA is available (sfa-cl.exe) that can be run from a Windows 
command prompt.  SFA can also be accessed by or embedded in other programs.  The command-line 
version will use the options that were last used in the GUI version of SFA.  Figure 90 shows the options 
available for the command-line version. 
 

 
 

Figure 90: Command-line version options 
 
To facilitate running the command-line version, the PATH environment variable can be set to include the 
directory where the command-line executables are located.  A batch file can also be created to run the 
command-line executable.  If the STEP file is not located in the same directory as the command-line 
executable, then the STEP file name should also include the directory pathname for the file.  When the 
command-line version is run, feedback is provided that is similar to what is shown in the Status tab as 
shown in Figure 91.  Error and warning messages are preceded with three asterisks (***) and highlighted 
with a different font and background color. 
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Figure 91: Command-line version output 
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10 Crash Recovery 
 
As explained in section 2.4, sometimes SFA will crash when processing a STEP file.  This is most likely 
due to either syntax errors in the STEP file or due to limitations of the IFCsvr toolkit.  If a crash occurs, 
one or more of the dialogs in Figure 92 might be shown.  If this happens, simply close the dialog(s), 
restart SFA, and process the same STEP file again by using function key F1 or F6 if processing multiple 
files.  SFA keeps track of which entity type caused the crash for a particular STEP file and won’t process 
that type again.  A message will be shown in the Status tab if a particular type of entity won’t be 
processed. 
 
The entity types that won’t be processed again are stored in a file *-skip.dat where ‘*’ is the name of the 
STEP file.  No matter what the reason is for the crash, that file will always be generated.  Even if you stop 
SFA in the middle of processing a STEP file, the file *-skip.dat will be generated.  Therefore, the next 
time SFA is run, the entity type that was being processed when you stopped SFA will not be processed.  
In this case, or if the syntax errors related to the bad entity are corrected, the *-skip.dat file can be deleted 
or edited. 
 

 
 

 
 

Figure 92: Dialogs displayed when the software crashes 
 
SFA might also crash when processing very large STEP files.  Popup dialogs might appear that say, 
“unable to alloc xxx bytes”.  In this case, deselect some entity types to process in the Options tab or use a 
User-Defined List of entities to process. 
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If SFA crashes, you can also see which entity type caused the crash.  Figure 93 shows that SFA crashed 
when processing an annotation_plane entity.  The entities of the type that caused a crash should be 
checked for syntax errors. 
 
Another way to prevent that entity type from being processed is to deselect, in the Process section of the 
Options tab, the category of entity that contains the entity that caused the crash.  That will prevent that 
entity from being processed along with all other entities of that category. 

 

 
 

Figure 93: Which entity caused a crash 
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